
SAMPLE PAPER 

1  A client program used to access the Internet services and resources available through the World Wide 

Web. 

(A) ISP  

(B) Web Browsers 

(C) Web Servers  

(D) None of the above 

2 "When a computer prints a report, this output is called_____." 

(A) hard copy  

(B) soft copy  

(C) COM  

(D) None of the above 

3 "=ROUND(2.15,1) entered in a cell displays" 

(A) 2  

(B) 2.1  

(C) 2.2  

(D) None of the above 

4 "=MOD(-3,2) entered in a cell displays" 

(A) -1  

(B) 1 

(C) -1.5 

(D) 0 

5 "To change the size of the chart without changing its proportion, then you have to press _____ as you 

drag a corner handle" 

(A) [Shift]  

(B) [Alt]  

(C) [Ctrl]  

(D) [F11] 

6 The default page orientation in Excel is 

(A) (A)Landscape  

(B) (B)Horizontal 

(C) Portrait 



(D) None of the above 

7 "In Excel, if you click on the Gridlines and Draft Quality check box on the sheet tab property sheet of 

page setup dialog box then" 

(A) gridlines will be print 

(B) gridlines will not be printed 

(C) sometimes print 

(D) None of the above 

8 To create a new blank presentation you could _____. 

(A) click on the New button 

(A) (B )use the File New command 

(B) Both of the above 

(C) None of the above 

9 In which menu Change Case command appears 

(A) Insert  

(B) Slide show  

(C) Format  

(D) Edit 

10 How do you make an inserted sound file play continuously over several slides?  

(A) "In the Custom Animation task pane, open Effects Options and set the sound to play for the 

desired number of slides" 

(B) "Using the Record Sound feature, press the Record button and play your music as you click 

through the whole slide show" 

(C) "Using the Play CD Audio Track feature, set the CD to play for the desired number of tracks" 

(D) All of the above 

11 The area on a slide that holds text that will appear in the presentation outline is a _____. 

(A) Textbox  

(B) Placeholder  

(C) bullet point 

(D) title box 

12 The purpose of AutoFormat command in Excel is to 

(A) create a professional and consistent look for your data 

(B) "choose between standard table formats that include borders, shading, font colours and other 

formatting options" 

(C) easily apply a consistent format throughout a workbook 



(D) All of the above 

13 Which of the following statements about search engines and Directories is true? 

(A) A search engine does not discriminate between good and bad sites. 

(B) A search engine displays all Web pages that contain your keywords and may list thousands of 

unordered results. 

(C) A directory is someone’s attempt to categorize the best sites available for a given subject or 

topic. 

(D) All of the above 

14 Which one of the following can be entered as a number in a cell? 

(A) "1,300.00" 

(B) (5000.00)  

(A) (C)1.1e+2  

(C) All of the above 

15 Which of the following a search engine continuously sends out that start on a homepage of a server 

and pursue all links stepwise? 

(A) spiders  

(B) packets  

(C) cookies  

(D) None of the above 

16 "What would you use for immediate, real-time communication with a friend?"  

(A) Instant Messaging  

(B) E-Mail  

(A) (C)Usenet  

(C) Blog 

17 The Internet uses 

(A) Circuit switching  

(B) Packet switching 

(C) Hybrid switching  

(D) None of the above 

18 The ascending order of a data hierarchy is : 

1. (A)Bit-byte-record-field-file-database 

(B) Byte-bit-field-record-file-Database 

(C) Bit-byte-field-record-file-database 

(D) Byte-bit-record-file-field-database 



19 Software instruction intended to satisfy a users specific processing needs are called _____ 

(A) System software 

(B) Microcomputer  

(C) Documentation  

(D) Application software 

20 "In computer terminology, information means" 

(A) raw  

(B) data  

(C) data in more useful or intelligible form 

(D) alphanumeric data program 

21 Which of the following is a part of the Central Processing Unit 

(A) Keyboard  

(B) Printer  

(C) Tape 

(D) Arithmetic Logic Unit 

22 What is meant by computer literacy? 

(A) (A)Ability to write computer programs 

(B) (B)Knowing what a computer can and cannot do 

(C) (C)Knowing computer related vocabulary 

(D) (D)Ability to assemble computers 

23 The software application that is used the most often is _____. 

(A) word processing  

(B) spreadsheet  

(C) database  

(D) graphical presentation 

24 A floppy disk contains 

(A) Circular tracks only  

(B) Sectors only 

(C) Both circular tracks and sectors 

(D) None of the above 

25 The first page that you normally view at a Web site is its: 

(A) Home page  

(B) Master page  



(C) First page  

(D) Banner page 

26 What is the function of the justification buttons on the toolbar? 

(A) To display a drop-down list of justification options 

(B) To display the four options for aligning text 

(C) To open the justification dialog box 

(D) To center the current line 

27 The binary number system has a base 

(A) 2  

(B) 4  

(C) 8  

(D) 16 

28 The arithmetic/logic unit performs the following actions: 

(A) checks data for accuracy 

(B) "does calculations using addition, subtraction, multiplication, and division" 

(C) "does logical comparisons, such as equal to, greater than, less than" 

(D) both calculations and logical comparisons 

29 CPU reads the information from secondary memory 

(A) Directly 

(B) "First, information is transferred to main memory and from there, the CPU reads" 

(C) Through registers 

(D) None of these 

30 A plotter is 

(A) An input device to produce good quality graphics 

(B) An output device to produce drawings and graphics 

(C) A fast output device using camera lenses 

(D) None of these 

31 A _____ is a collection of buttons which represent various operations that can be carried out within 

an application. 

(A) Buttons  

(B) Menu  

(C) Toolbar  

(A) (D)None 



32 The topmost bar in any application window is the _____. 

(A) It displays the name of the document or application. 

(B) Menu bar 

(C) Toolbar 

(D) Status bar 

33 Supercomputers are primarily useful for 

(A) Input-output intensive processing 

(B) Mathematical intensive scientific applications 

(C) Data retrieval operations 

(D) None of these 

34 E-mail 

(A) Cannot address many users 

(A) Does not provide protection given to first class mail 

(B) Always uses bridge to send messages in different networks 

(C) None of these 

35 Which of the following is a graphical package? 

(A) CorelDRAW  

(B) MS-Excel  

(C) MS-Word  

(D) None of these 

36 The gigantic work of simulating the airflow around an entire aircraft can only be done by using fast 

(A) Microcomputers  

(B) Minicomputers  

(C) Supercomputers  

(D) None of these 

37 Which of the rule mentioned below for range names is incorrect 

(A) names cannot be the same as a cell reference 

(B) in a range name you are allowed to use spaces or commas 

(C) range names can be directly used in formulas 

(D) the only separators allowed are underscore characters and/or periods between words 

38 What is the first step in MS-Word in changing line spacing? 

(A) To open the Format menu 

(B) To click the Line Spacing button 



(C) To select the paragraphs you want to change 

(D) To open the Paragraph menu 

39 "A mouse, trackball, and joystick are examples of _____." 

(A) pointing devices 

(B) pen input devices 

(C) data collection devices 

(D) multimedia devices 

40 The Save As... dialog box can be used 

(A) for saving the file for the first time to save 

(B) file by some alternative name 

(C) to save file in a format other than Word 

(D) All of the above 

41 The contents of the Clipboard remain the same until 

(A) you cut other text 

(B) you shut down your computer 

(C) you copy other text 

(D) All of the above 

42 You will probably use Borders in Word where 

(A) you wish to add emphasis to particular paragraphs 

(B) you wish to draw lines above and below or to left and right of paragraphs 

(C) you wish to surround the paragraphs with different styles of boxes 

(D) All of the above 

43 The Formatting Toolbar option are applied 

(A) to paragraph selection only 

(B) to character selection only 

(C) to both character as well as paragraph selections 

(D) None of the above 

44 A page break is used to do what? 

(A) Create a new page at the insertion point 

(B) Create a new page at the bottom of the document 

(C) Create a new page that cannot be deleted 

(D) Create a blank page at the top of the document 

45 "In which Word menu, Letter wizard command appears" 



(A) Format  

(B) Tools  

(C) Insert  

(D) Table 

46 "In Word, split cells command appears in _____ menu." 

(A) Table  

(B) Format  

(C) Insert  

(D) Tools 

47 Status bar shows different types of keys: 

(A) Num lock key  

(B) Scroll lock key  

(C) Caps lock key  

(A) (D)All of these 

48 In Excel the intersection of a row and column is called 

(A) square  

(B) cubicle  

(C) cell 

(D) worksheet 

49 "In Excel, once a range has been named, you can go to a range" 

(A) by selecting ranges using the name box 

(B) by selecting ranges using the [F5] key 

(C) both a and b 

(D) None of the above 

50 One of the statements is not true: 

(A) "In its default settings, a word processor does not hyphenate the text" 

(B) Hyphenating helps when you are dealing with thin columnar text 

(C) "By hyphenating, the looks of the justified thin columns will look greatly improved" 

(D) Microsoft Word hyphenates text in its default settings. SarkariExam.com 

51 Animation effects appears in the Standard toolbar. 

(A) True  

(B) False 

52 BIOS stands for Basic Integrated Operating System 



(A) True  

(B) False 

53 LENGTH() function is used to find the length of the string. 

(A) True  

(B) False 

54 The floating text (text not associated with objects in the chart) cannot be moved in the chart area. 

(A) True  

(B) False 

55 "Just as you can preview a worksheet before printing, it is not possible to preview a chart." 

(A) True  

(B) False 

56 "To insert a header or footer in a worksheet, select Header and Footer option in the File menu." 

(A) True  

(B) False 

57 You can add items to the Start menu of windows 

(A) True  

(B) False 

58 You can swap over the functionality of the left and right mouse buttons 

(A) True  

(B) False 

59 The AutoContent Wizard creates the structure and contents based on the choices you make. 

(A) True  

(B) False 

60 PowerPoint has more than twenty four slide layouts. 

(A) True  

(B) False 

61 Bullets and numbering appears in the standard toolbar. 

(A) True  

(B) False 



62 The Cell/range names are case sensitive. 

(A) True  

(B) False 

63 You can apply a color scheme to the current slide or to all slides in your presentation. 

(A) True  

(B) False 

64 99 sales is a valid name for a cell or a range. 

(A) True  

(B) False 

65 PowerPoint allows you to differentiate your own animation effects. 

(A) True  

(B) False 

66 Internet is not a commercial information service. 

(A) True  

(A) (B)False 

67 The network NSFnet was later renamed as Internet. 

(A) True  

(B) False 

68 The IP address space is divided into classes five in all which are given letters A through E 

(A) True  

(B) False 

69 The Request for Comments (RFCs) core topics are Internet and the TCP/IP protocol suites. 

(A) True  

(B) False 

70 The Back and Forward buttons can be used to visit only pages from the same website 

(A) True  

(B) False 

71 A protocol used for fetching e-mail from a mailbox is POP1 

(A) True  



(B) False 

72 All conversations on the IRC are in English 

(A) True  

(B) False 

73 The full form of ISP is Information Source Provider 

(A) True 

(B) False 

74 "A smiley, is a sequence of ordinary printable characters, or a small image, intended to represent a 

human facial expression and convey an emotion." 

(A) True  

(B) False 

75 You can stop using the spelling checker at any time by clicking the close button. 

(A) True  

(B) False 

76 The View menu in Word is used to create header and footer. 

(A) True  

(B) False 

77 Check boxes are used to present options requiring individual on/off decisions in Message boxes. 

(A) True  

(B) False 

78 Firmware is software that is embedded in a hardware device 

(A) True  

(B) False 

79 Primary memory has higher storage capacity than secondary memory. 

(A) True 

(B) False 

80 Pressing F1 is a common way to invoke help in Windows? 

(A) True  

(B) False 



81 "To select an entire document in Word, move the pointer to the left of any document text until it 

changes to a right- pointing arrow, and then double-click." 

(A) True  

(B) False 

82 [Ctrl]+[U] selects the italics style for the selected text. 

(A) True  

(B) False 

83 A blank line is also called as a paragraph. It is called as an empty paragraph. 

(A) True  

(B) False 

84 [Del] key deletes the text to the left of the insertion point. 

(A) True  

(B) False 

85 Word includes a number of AutoCorrect entries. We can use these entries but cannot modify them. 

(A) True  

(B) False 

86 You can create your own dictionaries in Word. 

(A) True  

(B) False 

87 "When you create a formula that contains a function, the Insert Function dialog box helps you enter 

worksheet functions." 

(A) True  

(B) False 

88 "In Word, you can change the character spacing from the toolbar." 

(A) True  

(B) False 

89 "e-commerce consists primarily of the distributing, buying, selling, marketing, and servicing of 

products or services over electronic systems such as the Internet" 

(A) True  

(B) False 



90 Word template does not include style formatting. 

(A) True  

(B) False 

91 The Blank Web page template of Word contains pre-formatted or pre-designed options. 

(A) True  

(B) False 

92 The Word organizer does not copy the Auto-Text entries. 

(A) True  

(B) False 

93 Different cells with in a row can have different heights. 

(A) True  

(B) False 

94 The AutoFit to contents enables Word to widen or narrow columns based on the contents you insert 

in Insert Table. 

(A) True  

(B) False 

95 Print Preview of Word does not allow you to do any editing. 

(A) True  

(B) False 

96 "From the Mail Merge Helper dialog box, you can only open an existing data source but cannot create 

a new one." 

(A) True  

(B) False 

97 The name box is at the left end of the formula bar 

(A) True  

(B) False 

98 "In Excel, The delete and clear commands perform the same function." 

(A) True  

(B) False 



99 You cannot change the Font style of the entire workbook by a single command. It can change only 

worksheet by worksheet. 

(A) True  

(B) False 

100 The spelling and grammar check can only be done once the text is selected. 

(A) True  

(B) SarkariExam.com 


